YASKAWA Electric Corporation
Machine Controller MP3000 Series
Extended MEMOBUS Driver

Supported version TOP Design Studio V1.4.3 or higher {Rl

TOP

"
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We would like to thank our customers for using M2l's "Touch

Operation Panel (M2l TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device".

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 10

Describes how to set up communication for external devices.

5. Supported addresses Page 15

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration

The system configuration of TOP and "YASKAWA Electric Corporation — MP3000 Series Ethernet” is as follows:

Series Link I/F Communication method System setting

3. TOP communication . )
Ethernet Connector on Twisted pair

MP3000 CPU 201 Ethernet( UDP settin
CPU unit ( ) seng cable*Note 1)

4 Extended MEMOBUS

*Note 1) Twisted pair cable
- Refer to STP (Shielded Twisted Pair Cable) or UTP (Unshielded Twisted Pair Cable) Category 3, 4, 5.
- Depending on the network configuration, you can connect to components such as the hub and transceiver, and in this case, use a

direct cable.
M Connectable configuration
+ 1:1 connection (one TOP and one external device) connection

] [UINE -

— | HUB '

* 1:N connection (one TOP and multiple external devices) connection

D m_: M*E ......... M#T

| HUB |—
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device [ = |

PLC select [Ethernet]

Filter : [ [alD | Search
@ Model () Vendor

Vendor Model

A
M2I Corporation & Mp300
MITSUBISHI Electric Corporation & Mp2000

R m
LS Industrial Systems

& High Speed Ethernet Server
MODBUS Organization

& SR100
SIEMENS AG.

Rockwell Automation

GE Fanuc Automation
PANASONIC Electric Works
YOKOGAWA Electric Corporation
Schneider Electric Industries

KDT Systems

RS Autnmatinn s

4 Eack | B Mext *® Cancel
Select Device H

PLC Setting[ Mp3000 ]

Alias Name : [PLC1 BindIP: lAuto ~
Interface @ |Ethernet ~

Protocol : | MP3000 Extended Memobi
String Save Mode @ |First LH HL Change

[J use Redundancy

Comm Manual

Primary Option

P

w2 e FH o FH| [ E
Ethernet Protocal

Fort 1024 -
Timeout msec
=

q

Send Wait - msec

Datz Code BINARY
4 Back v oK ® Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.

Select "YASKAWA Electric Corporation”.

PLC Select the external device to be connected to the TOP.

Interface Protocol
MP3000 Series Ethernet MP3000 Extended

Memobus RTU
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3. TOP communication setting
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting
M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Ethernet]

— Set the TOP communication interface in TOP Design Studio.

Project Opticn

I ctaroe HIL W Add PIC T -
[

¥ D TOP Setting
: 0%

Option Module Setting
- FieldBus {0}

-4 RFID (0)

Device Setting

® COM1 (0)

Date / Time Sync.
Project Option

Use HMI Setup

Hmi Setup Option

Change PLCIC]

Screen Option

Screen Change

[ Delete PLCIDI

Unit Convert

HmiSetup

Global Lock & Touch

Project Style = Splash

Initialization | Edit |

PLC Buffer Sync.

X

¥ COM2 (0)
o® COM3 ()
- Ethernet (1)
i - PLC1: Mp3000
Wireless (0)
. USEDevice (0)

Project Setting

HMIDisable =0

Project Name=Mew project
Start Mode=Menu

Start Screen No. =1

Latch Use=0

Latch Set=0~0
Communication Error Message=0
UsBErrorMessage=0
StorageErrorMessage=1
DatabaseMessage=1

A

Control Panel

!=*! Option

System Devices mﬂervice

fw) Ethernet x
-Port
i - Ethernet Port (ETHI = 0
i l 7 - - ernet Port :
Link Speed : Auto -
PLC Secur ity Dat &/Time
MAC Address @ 00:00:00:00:00:00
IP Address :  192.168.0.50
Subnet Mask :  255.255.255.0
o 8 B Gateway :| 192.168.0.1
- s ol )
"l"" Default Gateway
Ethernet Serial HOM | DNS (1) ]
DNS (2) ;]
-Ethernet
I - “\ Prinary IP : 192.168.0.50 =
k "
el Ping Cable Status :
Diagnost ic File Pin
c Manager . Bridge Hode : [JUse Bridge
Check duplicate | Apply | Cancel
Items TOP External device Remarks
IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51
Subnet Mask 255.255.255.0 255.255.255.0
Gateway 192.168.0.1 192.168.0.1
*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP 192 . 168 . 0 . 0) should match.
*Note 2) Do not use duplicate IP addresses over the same network.
* The above settings are examples recommended by the company.
Items Description
IP Address Set an IP address to be used by the TOP to use over the network.
Subnet Mask Enter the subnet mask of the network.
Gateway Enter the gateway of the network.
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(2) Communication option setting

M [Project > Project Property > Device Setting > ETHERNET > “PLCT : Mp3000“]
— Set the options of the MP3000 Series Ethernet communication driver in TOP Design Studio.
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Project Option

- Change HMIH]

“ AddPLC[A] | THITal Change PLCIC)

m Delete PLC[D]

TOP Setting
] 5Y5 : RD1520%

- FieldBus (0)
-8 RFID (0)
Device Setting
B COM1 (0}
-rg® COM2 ()
-Fg® COM3 (0)

- |USBDevice (0)

#8 Option Module Setting

-4 Etherpe
PLC1: Mp3000
Wireless (0

PLC Setting[ Mp3000 ]

Alizs Name : [PLC1 BndIP: |Auts v

Interface : |Ethernet ~
Protocol : | MP3000 Extended Memobt ~
String Save Mode : (First LH HL Change

:

[ use Redundancy

AND ~
Timeo .
Primary Option
P (o2 F] s 2|0 & [ F
Ethernet Protocol TCP v
Timeout msec
Send Wait msec
HMI Port
Data Code BINARY

Comm Manual

Apply Close
* The above settings are examples recommended by the company.
Items Settings Remarks
Interface Select "Ethernet”. Refer to “2. External
Protocol Select the communication protocol between the TOP and an external device.

device selection”.

@® Communication options when selecting Extended Memobus RTU

IP

Enter the IP address of the external device.

Ethernet Protocol

Select the Ethernet protocol between the TOP and an external device.

Port

Enter the Ethernet communication port number of the external device.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external
device and sending the next command request.

HMI Port

Enter the Ethernet communication port number of the TOP.

Data Code

Select the data code between the TOP and an external device.

@ Communication options when selecting MP Extension Ethernet

IP

Enter the IP address of the external device.

Port

Enter the Ethernet communication port number of the external device.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external

device and sending the next command request.

Ethernet Protocol

Select the Ethernet protocol between the TOP and an external device.
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3.2. Communication setting in TOP
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication

interface setting

B [Main Screen > Control Panel > Ethernet]

Ethernet

Run

YNC
Yiewer

i
o
@ System

:[ ETHT |'H 0 "] i
:[ duta H J’))
00:15:10:05:38: C5
192.168.0.50 Sound
285.255.255.0
192.168.0.1 ,:
@ Defau |t Gateway e~

MR
dnalysis

[ 192,168.0.50

ETH1 Connected
O Use Bridoe

-Port
Ethernet Port
n ! Link Speed
i MAC Address :
FLC 5 IP Address
Subnet Mask
[H-'-.] A Gateway
{11110
Et hernet DNS (1)
| DMS (2D
m Bl . Fthernet
h Primary [P :
Diagnost ic
Cable status
Bridge Mode :
[System]

lCheck duplicate] [ A | v ] Cance! l

Close

=

Items TOP External device Remarks
IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51
Subnet Mask 255.255.255.0 255.255.255.0
Gateway 192.168.0.1 192.168.0.1
*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match.
*Note 2) Do not use duplicate IP addresses over the same network.
* The above settings are examples recommended by the company.
Items Description
IP Address Set an IP address to be used by the TOP to use over the network.
Subnet Mask Enter the subnet mask of the network.
Gateway Enter the gateway of the network.
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(2) Communication option setting
B [Main Screen > Control Panel > PLC]

il PLG

YHC
Yiewer

Screen
shot

ERI2 e B X
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Svst Driver(ETH) | PLCT(Mp3000) | |
Ir—| Interface | Ethernet [~]
m Protocol | MP3000 Extended Men|~
PLE Bind IP [(Auto -]
Ip [192}5] [eels] [0 5 1 15
[M] Ethernet [ TCP_|~]
Ethernet | POt 1024 |3
Timeout 300 |5 msec
m send Wait msec
HMI Port 1025 |3
P | Data Code B R[]
[Systeﬂ[ Diagnostic H3'ing Tesfl [ App |y “Cancel ]

* The above settings are examples recommended by the company.

Items Settings Remarks
Interface Select “Ethernet”. Refer to "2. External
Protocol Select the communication protocol between the TOP and an external device. device selection”.

Communication options when selecting Extended Memobus RTU

IP Enter the IP address of the external device.
Ethernet Protocol Select the Ethernet protocol between the TOP and an external device.
Port Enter the Ethernet communication port number of the external device.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external

device and sending the next command request.

HMI Port

Enter the Ethernet communication port number of the TOP

Data Code

Select the data code between the TOP and an external device.

@ Communication option

s when selecting MP Extension Ethernet

IP

Enter the IP address of the external device.

Port

Enter the Ethernet communication port number of the external device.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external

device and sending the next command request.

Ethernet Protocol

Select the Ethernet protocol between the TOP and an external device.

External device connec
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3.3 Communication diagnostics

B Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the port (ETH1/ETH2) settings you want to use in [Control Panel > Ethernet] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
configuration Connection cable name OK NG 1. System configuration
TOP Version information oK NG
Port in use oK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG 2. External device selection
Communication 3. Communication setting
diagnostics oK NG
Ethernet port setting IP Address oK NG
Subnet Mask oK NG
Gateway OK NG
External device CPU name oK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix OK NG ) )
Other detailed settings oK NG 4. External device setting
Ethernet port setting IP Address oK NG
Subnet Mask oK NG
Gateway OK NG
Check address range 5. Supported addresses
OK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Set as below using "MP Series” Ladder Software "MPE720". For more detailed setting method than that described in this example,
refer to the PLC user manual.

& Do not use duplicate IP addresses over the same network.

1. Run the "MPE720" software.

2. Create a new project file or open an existing file.

3. Click "Module Configuration".

4. Double-click “218FD" to open the configuration window.

5. Configure as follows. (Example shown below.)

|[ Fte  Edit view |
PT#:— CPU#:— ICIR#05 [00D00-DOZFF |

Transmission Parameters |Status | =

~ Transmission Parameters =
Module Mame Definition

IP &ddress O V= P =T P L == I | == I 1 510 Equipment name |COMTROLLER NAME
Subnet Mask B [ [E A 0 = -2

Gateway IP Address @ [T = [T = [T = [T = (0-28) Detail Definition_|

— Connection Parameter
~Message Communication

E ; Ihe mllqwin%garameters far message communications can be easily set,
asy setting | Connections(C MO) 01-10 can be set to receive data autornatically,

m

cND tocal | poge Ip Address | H0d° C‘.’r’;;id Pr}"y‘;"' Code | Detai Node Nar-—
01 05100 |132.168.001.002 05000 UDP v |Bdended MEMOBUS v |BIN | Setting”
02 f— hd hd | Setting” —
03 — hd hd | Setting”
04 — hd hd _*| Setting”
05 — hd hd | Setting”
| 06 |— =] l=| | Sefting” |
07 — =) = x| Setting” | <
] L8

Cannot the overlap to local station port number used by the communicate the /0 message,

/0 Message Comrmunication
@+ Disable
¢ Enable

Easy setting | Itis possible to set easily that communicate the /0 message,

Data update timing ILDW -l Scan I
Read/ Local MNode Connect Protocol -
I Wite Port Node IP Address Port T Tz Code Detail Node Nam Il
| | | | | |
For Help, press F1 [ MNUM 4

(For more details on configuration, refer to the Ladder Software manual.)
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6. Double-click "Detail” to open the configuration window.

Detail Setting

Autornatically Reception

¢~ Disable
+ Enable

Transmission Buffer

Slave |/F Register Settings
Readout of Input Relay
Readout of Input Register

—

Unable to automated reception. when the
protocol type is no control sequence,

Head REG
IWwooooo
IWiaoaoa

Readout / Write—in
Readout / Write-in
Feadout / Write—in
Readout / Write-in
Readout / Write-in
Readout / Write—in

according to this

of Coil

of Hold Register
of Data Relay

of Data Register
of Qutput Cail

of Qutput Register

Write — in width of Coil/Hold Register

! ﬁuutomatic input processing delay

parameter,

[ —
[
i
i
[
[

Lo: [Mwoooog
HI: [MwT0dees

Write — in width of Data Relay/Register | |GWODO0O

HI: |GW2097151

Write — in width of Output Coil/Registar | o, [OWOOOOO

HI: [OWI1TFFF
1] ms (0-100)

The influence on a low-speed scanning can be adjusted

[ Attention ] Itis not jn the sefting of the cormmunication
period of an autormatic reception,

Ok I Cancel
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7. Write the "MSG-SND LADDER PROGRAM ".

zetting paral ru

firsl scan after power on
=trues

i
IF

a|[W]Dest [¥]Dsta [WIWidth

BETW okanoan 00000 ooz

ra
—

[N |
DWD00D2=1

L |
tDWIO004=0x000B: //UBH=writ ire hold resister [Extended)

zet for data address (FPARRMDG) and data =ize (PARAHOE)

[NL |
£ DWD0007=1

IEREREE

/ool oﬂset (PARAMIE
Ainput relay oftzet (FARAW)
:::rl1 regicter otfczet lSPﬂH

old register offset

o L s R e}

/
/
/
/

-
=

DEODOZ00  DBOCOZ0N [ U [VICount DEDOOZ0A
i 1 O

INE

TON[ 100 =] a1000 CAnon 21

execule abort timeoul
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DEOO0Z04 DELOOZTT DB]ELQZU]
L l A
tiwsout conp | et e abort
EHIIUUIZH
11
relesze sending conmand in Bz after abort ed
DE00 207 DED00 203 DEDO0203
T o A O
abort wa iting end wa it ing
&d
DEOO0Z08
'\'O.Iil.lilg,
DEOO0208 NIOED W] Count DBI00209
L TONDTOns] | OBOOD DIWD0029 O
vaiting - waiting end
ed
SB000034 DEIOQZ0D
—_ ’
# bfter 5.0s, § o= ON
Scan Start
up Relaw
Denoozo0 OEDOO211 DEOOO:Z212 DEDOOZ08 [ - | 5et [N Eount LEIO0200
Lt l A A |/ ToNLioas] | 00100 | DHOOO30
Ha-0N comp lete error wa it ing - execute
% HEG-SND —
[BIEzecute '[B]Busy
OEOOOZ00  DE0coz10
execule -
[B]labart [B]Conp | ate
DBOOOZ01 - DBOCOZ11
abard comp |l etz
[W]Dew Tyr [B]Errar
QNoos OBoCoz1z
grror
[WIFroTwp
000
[WICirHMo
Q0007
[WICh-Ne
Q000
[&]Param
000000
| o
- EF |
TR | e B 0R0002 115t rue |
[WL]Dest
N i [ e | DRo00Z4 ||
TN &DDl"t L count morms
1w
-_
[2 -= [
MM e B 0002 125t rue |
[ " binones
Ml |
% 1 L TG count abnor
I|o.||}."
zaving the rezult and stetus
- -
©DW0CO26=DM00000; / /result
OWnEo/=0M0nnnT; 7 /status
| oo
DEONOZ04  DROODHE OEAN0 200
T || ry e
4 Lineout on pulse Limeout occ
ured
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B | IF B DEOOOZ00==1 rue

45787
a [[WL]De=t
T (- - owooozs ||
1689 ¢ count tingn
ut

.
% L CHD K

7. Send the configuration details to the device by using “Transfer”.

8. Boot up the device once the transfer is complete.
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5. Supported addresses
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The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Device Bit Address Word Address 32bit Remarks
Holding Registers MB 0 — 1048576F MW 0 — 1048576

Data Registers GB 0 - 2097152F GW 0 - 2097152

Input Registers IB 0 — 17FFFF IW 0 — 17FFF L/H *Note 1)
Output Registers OB 0 — 17FFFF OW 0 - 17FFF

System Registers SB 0 — 65534F SW 0 - 65534 *Note 1)
*Note 1) Cannot be written
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